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Sunburst Software Solutions, Inc. Presents
A Complete Installation Presentation of:

Construction Application for Payment Solution (CAPS)© & 
QuickBooks® Pro/Premier 2003-2006 & Enterprise Solution 3.0-6.0

For Use With CAPS Version 5.0

http://www.sunburstsoftwaresolutions.com/



Overview:
Construction Application for Payment Solution (CAPS) works with QuickBooks® to help you or 
your clients create Percentage of Completion contract billing on original AIA G702 “Contractor 
Application for Payment” and G703 “Continuation Sheet” and the Construction Manager-Advisor 
AIA G702 and G703 (or similar plain paper forms) without time-consuming data entry.

Because CAPS utilizes existing QuickBooks data:
• You can reduce or eliminate errors

• You can expedite the payment process, 
• Anyone in your office can generate these billings
• You save time and money

Key Benefits:

� Get paid faster
� Save time on contract billings through 

seamless integration with QuickBooks

� Create accurate, timely, legible billings
� Eliminate transposition errors
� Stop entering the same data twice

� Uses your existing QuickBooks data
� Simplifies critical areas of your business
� Makes your job more efficient
� Allows you to concentrate on your business

� Designed specifically to integrate with 
QuickBooks®; since QuickBooks Pro 99

Construction Application for Payment Solution:
Generate Quick, Accurate Billing Information Using 
the Standard AIA Format.



Welcome

Welcome to the Construction Application for Payment Solution (CAPS)/QuickBooks 
Data Integration presentation.  This document will provide you with the information 
necessary to successfully integrate CAPS with QuickBooks.

This presentation should be used along with the Flash training demonstration provided 
on the Demonstration page of our site, the installation CD and either the whitepaper, 
printed manual or in-program Help File.  In CAPS click on Help->Contents or Help-
>Search for Help on……
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Why was CAPS created?

Nancy Smyth, President of Sunburst Software Solutions, Inc., has utilized Intuit 
products in a variety of industries since 1986, specializing in the construction 
industry, and has been a Certified QuickBooks ProAdvisor since 1999.

Providing bookkeeping services for several small Union and Non-Union construction 
firms in Connecticut, Nancy knew QuickBooks® was a great tool to be used not 
only for herself, but also by the small business owner.

While completing a job-costed payroll for 10 employees or a progress invoice within 
QuickBooks® was a fast and efficient process, completing the required Certified 
Payroll Reports and AIA Billing would take hours to complete.

Distaste for these tedious tasks led to a lengthy search for someone to extract this 
information from QuickBooks® and assemble these forms, ready to be signed and 
submitted.

Entering the same information multiple times in QuickBooks and an Excel spreadsheet, a 

standalone billing program, or another software program was a time-consuming, highly error prone, 

and tedious process taking hours each week or each month to complete.

Finding a way to automate these tasks would free up time, increase accuracy, and reduce the risk of 

transposition errors – which in turn would allow the contractor to be paid faster.



Creating an AIA billing using a manual 
method

This is a sample of the AIA billing format created in an Excel Workbook.

First the user must create “Worksheet Templates” for both the Application for Payment and the 

Continuation Sheet that contain information that does not vary each month..  

Each month as they are ready to make a draw request they must create a QuickBooks Progress 

Invoice and print it out.  

Then they must open the Workbook, make copies of their templates and manually enter the required 

information.

These individual worksheets contain complex mathematical formulas that can be broken quite 

easily.

All in all the manual transfer of data is a tedious and error prone task.



Problems that arise from manual methods

� Time consuming task

� Easy to transpose numbers

� Error prone process

� Tedious process

� Inaccurate billings

� Illegible billings if completed by hand

� Missing information

� Billings do not meet compliance monitoring

� Billings are not approved

� Payments to the contractor is delayed

� Overall frustration & dissatisfaction with QuickBooks due to lack of functionality

CAPS extends the power and functionality of QuickBooks Pro, Premier, Premier Contractor, or 

Enterprise.  QuickBooks on it’s own cannot produce the required billing format required under AIA 

billing, which means that the end use must re-enter the data using the required format using either a 

stand-alone program, handwritten forms, or elaborate Excel spreadsheets that must be updated with 

each new billing.  Duplicate data entry in multiple programs is time-consuming and error prone.

Key Benefits of using CAPS in conjunction with QuickBooks

�Saves time on contract compliance

�Creates accurate, timely, legible billings following the AIA format

�Eliminates transposition errors 

�Eliminates duplicate data entry

�Simplifies critical areas of clients business

�Expedites the payment process

Key Features of CAPS

�Uses existing QuickBooks data from Job Records, Estimates, and Progress Invoices

�Holds required information that QuickBooks has no means of tracking in linked records within its 

own database

�Print on AIA original G-702/703 or AIA G-702/703 CMa forms

�Print plain paper version of the G-702/703 and G-702/703 CMa

�Handles Fixed or Variable Rates of Retainage Calculations

�Easily handles Taxable Contracts

�Generate 30+ common Contract Documents or create your own custom documents



The Bigger Picture

� These billings are required to be submitted by General Contractors, 
Subcontractors, Developers, or Builders under various circumstances

� It takes hours each month to complete these forms by hand.

� The contractor typically doesn’t receive payment until 60-90 days 
from the time the billing is generated.

� QuickBooks holds 75% of the information required to complete the
forms.

� The problem – how to get that data!

Typically contractors have to wait 60-90 days from the date they submit the draws before they are 

paid; additionally, if there is a problem with the billing they are not notified until it is time for the 

first draw to be paid – in the mean time they have submitted additional billings.

In situations like this, not only is payment delayed; but all invoices submitted up to this point must 

be corrected and resubmitted; causing a longer delay in payment and cash flow problems.

When this happens the contractor becomes extremely frustrated with QuickBooks due to the lack of 

functionality and begins the search for a higher-end construction specific software program that will 

automate billings and eliminate transposition errors; however, these programs can cost thousands of 

dollars and require hours of specialized training.



The thought process, program design, and 
solving the problem

Database of information not 

contained in QuickBooks, 
and associations of 

QuickBooks data to 

reporting requirements.

CAPS accesses the Progress Invoice information 
from QuickBooks on a read-only basis, merges 

additional information and uses Excel to format 

the required report using plain paper.

1. QuickBooks with some fine tuning – specifically the use of the Estimating/Progress 
Invoicing functions, and utilization of the “Ship To” Address Block in the job record to 
hold the project number, project name, and physical location – holds roughly 80-90% 
of the required information.

2. The Intuit Software Development Kit (SDK) provides access to Job records, Estimates 
and Progress Invoices on a read-only basis (which means your clients data is totally 
safe because nothing is written back to the QuickBooks file.

3. Construction Application for Payment Solution would contain in it’s own database, 
through the one-time creation of “linked records”, missing information about jobs; 
that QuickBooks either provides no means of tracking or cannot be reliably tracked and 
read due to limitations of the SDK.

4. The information from both programs would then be “merged” and formatted into the 
correct layout using Microsoft Word and Excel and printed.

5. If AIA Original documents are required, the user purchases the appropriate forms, 
completes a printer alignment in CAPS, feeds the forms into their printer, and prints the 
information onto those documents.



How Construction Application for Payment 

Solution Accesses QuickBooks

Construction Application for Payment Solution (CAPS) is written using the Intuit 
Software Development Kit (SDK) and accesses the QuickBooks® data file on a read 
only basis – in other words, CAPS only reads information that has already been 
entered in QuickBooks® and manages that data in a way that is unique to certain 
portions of the construction industry that QuickBooks® cannot accomplish itself 
without ever writing anything back to the data file.

For more information on how CAPS utilizes the Intuit Software Development Kit we 
have provided the following article

http://www.sunburstsoftwaresolutions.com/articles/CAP%20SDK%20Utilization.pdf



What information does CAPS access?

CAPS  utilizes the following QuickBooks items:

� The “Bill To”, “Ship To”, “Customer Type”, “Job Status”, and “Job Description”

information contained in the QuickBooks Job Record

� QuickBooks Estimates

� QuickBooks Progress Invoices

How does CAPS utilize this information?  Refer to the following article

http://www.sunburstsoftwaresolutions.com/articles/CAP%20Info+.pdf



What Functions Does Construction 
Application for Payment  Solution Provide?

By reading basic information from Estimates, Progress Invoices, and Job records in 
QuickBooks, and combining that with other required items that QuickBooks provides 
no means of tracking (which are stored in “linked records” in Construction Application 
for Payment Solutions own database), CAPS will generate a plain paper version of the 
G-702 – Contractor Application for Payment and G-703 Continuation Sheet and G-
702/G-703 CMa OR will print the required information on AIA Original G-702/G-703 
and G-702/G-703 CMa versions that you purchase and feed into your printer.

Additionally, CAPS can produce various Contract Documents, deal with several 
different methods of retainage, handle negative invoices or credits, track and bill for 
retainage, and generate a convenient “Billing Worksheet” for the next payment 
application.



Advantages of the QuickBooks 2004-2006 

Data Interface*

� CAPS Menu Items can be added directly to the QuickBooks  Customer Menu

� CAPS can be automatically notified when a new customer, or job is added to QB, 
so that you can complete the additional information required on the billing forms 
that QB doesn’t handle while having all the proper paperwork in front of you

*Important Note:

These options are only available if you are using QuickBooks Pro/Premier 
2004/2006 or Enterprise Solutions 4.0/6.0 editions, and complete instructions for 
accomplishing this are provided in the programs manual. 

Through improvements made in the Intuit SDK, features like the above give 3rd party applications a more 
“integrated” look and feel.  Instructions for accomplishing this are provided in the manual included with the 
program.



Prerequisites Before Starting –

How to ensure a smooth integration

Installing & integrating CAPS with QuickBooks is an easy process – most times this 
setup is minimal.

There are some things that can cause this process to not go smoothly, such as 
improperly updated computers/programs and failure to read the manual – to avoid 
any potential pitfalls, refer to the Quick Start Guide provided with the manual and 
be sure that all items listed have been reviewed.  The Flash Training Demonstration 
provided on our site or on the CD will cover all the basics.

The Quick Start Guide provided with each manual covers such items as the following:

•The windows operating system has all critical updates & service patches applied

• Microsoft Word & Excel are installed on the computer & have all service patches applied

• All QB updates have been downloaded & are installed properly

• Verify that QB Preferences are set as outlined in the manual

• Insert the CAPS installation CD and from the Installation Manager select the Flash training demonstration 
for a basic overview if you prefer NOT to read the manual

• Verify Setup of QuickBooks Jobs, as outlined in the manual

• Setup Retainage Accounts and Items, as outlined in the manual

• Setup and Create Estimates, as outlined in the manual

• Setup and Create Progress Invoices, as outlined in the manual

•Visit http://www.sunburstsoftwaresolutions.com/support-area.htm & download the most up to date 
troubleshooting & error messages



Integrating CAPS with QuickBooks – A 

Step-by-Step Overview

� In most cases, inserting the installation CD starts the Setup Manager. 

Select Install Construction 
Application for Payment 
Solution to begin the 
program installation.

You may also view 
demonstrations of Wage 
Manager and Certified 
Payroll Solution.

Network installation 
instructions are provided 

in the manual.

What can go wrong and why?

We have thoroughly tested the installation process with various hardware and software 

configurations, however, it is virtually impossible to know exactly how someone else has setup 

their computer, their network, etc.

Spyware programs, such as Microsoft Anti-Spyware, can cause installation issues and it is best to 

disable spyware prior to installation.

Other things that can cause installation and integration problems include:

� Insufficient permissions to install programs in a network environment

� Windows updates have not been installed

� Office updates have not been installed

� Windows 98 computers have been upgraded to Windows 2000 or XP 



Integrating CAPS with QuickBooks – Initial 
Setup

� While CAPS is installing, open the QB company file in single user mode, logged in 
as the QB Administrator, and minimize QB.

After you have accepted the license agreement, you will be taken to the Initial Setup screen.

Here you will be required to enter the following information – if you purchase the program via electronic 
download:

Company Name for Reports

This is the information that you provided at the time you placed the order.

Serial Number

The product serial number

License Key

The product license key

Data Location Path

The default is to install CAPS to C:\Program Files, if you have more than one drive, you can change the 
location of where your data is stored.

Troubleshooting

Altering the Company Name in any manner will result in an “illegal license agreement” error message, this 
includes having the CAPS Lock on when the licensed name is in both upper and lower case.  If the company 
name is not correct, contact technical support to notify us of the problem.



Integrating CAPS with QuickBooks:
Granting Permissions – A 2 step process for users of QuickBooks 
2003/2004, Enterprise Solutions 3.0/4.0

CAPS will now access your QuickBooks 
Pro/Premier/Enterprise  company file 
requesting that you grant it permission to 
access your file.  The following QuickBooks 
Integrated Application Screen will appear click 
the Yes, Always button.  

On the Confirm to Proceed screen, select the Yes 
button.  

Troubleshooting:
If this screen does not appear there are two 

possible problems:
1.   You are using QuickBooks Pro/Premier 2003 or 

Enterprise 3.0 and the Request Processor 
(which is how CAPS talks to QuickBooks) did 
not install correctly.  Use CTRL+ALT+DEL to 
bring up the Windows Task Manager, select 
End Task for both QB and CAPS.  Contact 
Technical Support for help installing the New 
Request Processor.

2.   You are using QuickBooks Pro/Premier 
2004/2005 or Enterprise 4.0/5.0 and there is a 
QuickBooks update that has not installed 
properly.  We see this on occasion, mostly with 
Dell & HP computers running Windows XP.  
Please contact Technical Support should this 
happen.

Permissions must be granted by the QuickBooks Administrator, while being in single-user 
mode.  This is a one-time process.

Selecting the “Yes, Always” option is entirely safe.  CAPS does not access the QuickBooks 
company file unless it is instructed by a “human” to retrieve invoice information.

Troubleshooting:

If this screen does not appear there are two possible problems:

1. You are using QuickBooks Pro/Premier 2003 or Enterprise 3.0 and the Request 
Processor (which is how CAPS talks to QuickBooks) did not install correctly.  Use 
CTRL+ALT+DEL to bring up the Windows Task Manager, select End Task for both 
QuickBooks and CAPS.  Contact Technical Support for help installing the New Request 
Processor.

2. You are using QuickBooks Pro/Premier 2004-2006 or Enterprise 4.0-6.0 and there is a 
QuickBooks update that has not installed properly.  We see this on occasion, mostly 
with Dell & HP computers running Windows XP Home Edition.  Please contact Technical 
Support should this happen.



Integrating CAPS with QuickBooks:
Granting Permissions – the 2nd step

To grant the 2nd set of permissions:  In QB, Choose Edit -> Preferences -> Integrated 
Applications -> Company Preferences
Highlight Construction Application for Payment Solution in the box and click Properties to 
be taken to the Access Rights tab

To allow CAPS to access the QB file 
even if it is closed – check Allow this 
application to login automatically.  
The Login as should be someone 
with Administrator rights or 
sufficient privileges to access billing 
information.

This is our #1 support call

If you choose to run CAPS with QuickBooks closed, you will notice a difference in the amount of time in 
which the two programs begin their initial communication.

Construction Application for Payment Solution follows the protocols of the User Permissions that have been 
established within the QuickBooks data file.



Integrating CAPS with QuickBooks: 
Granting Permissions – QuickBooks Pro/Premier

2005/2006 and Enterprise Solution 5.0/6.0

Intuit has made it easier to grant 
permissions in these versions, and 
allows Developers such as ourselves 
to indicate “how” we will be 
accessing your QuickBooks company 
file. 

On this screen you should check the 
“Yes, always allow access even if 
QuickBooks is not running”.

This screen also indicates that CAPS 
does not requires access to personal 
data such as Social Security 
Numbers, and that it access the QB 
file on a read-only basis

Because of stricter permission settings in Enterprise 5.0/6.0, some users may experience difficulties, 

if you experience error messages stating that the user chosen in the “Login as” section does not have 

sufficient permissions to access information”, please refer to the Minimum Permission Settings for 

Enterprise 5.0/6.0 Users, found in the printed manual and the CAPS In-Program help.



Integrating CAPS with QuickBooks: 
Granting Permissions – QuickBooks Pro/Premier 

2005/2006 and Enterprise Solution 5.0/6.0

The Access Confirmation screen shown 
to the left simply provides an overview 
of the permissions that you have just 
granted to CAPS, and confirms that it 
will only Read QuickBooks Data.

Special Note for Enterprise 
5.0/6.0 Users: Due to the dramatic 
changes that Intuit has made in the 
entire User Permission process only in 
Enterprise – we have documented what 
the required permissions are that CAPS 
needs in order to run correctly under 
any user other than the QuickBooks 
Administrator, and have included them 
in the manual.



Integrating CAPS with QuickBooks:

This concludes the most crucial portion of the integration of the two 
programs.

After you have completed granting permissions, minimize QB and you will 
have been automatically taken to the System Setup - Addresses section of 
CAPS.

Following the instructions found in the manual, complete the necessary 
information on the Addresses Tab, and then System Setup and Options tabs.

When you have completed this you are ready to begin Setting up 
Construction Application for Payment Solution to Work with QuickBooks!



Setting Up CAPS to work with QuickBooks:
Starting CAPS

You are now ready to run the first AIA billing with CAPS.

From the Main CAPS Menu, choose File -> Application for Payment



Setting Up CAPS to Work With QB:
Entering Dates

You are now ready to run the first AIA billings with CAPS.

From the Main Construction Application for Payment Solution screen, 
choose File -> Application for Payment.

You can choose to retrieve invoices:

1. by a date range that they were created

2. or an actual invoice number range

3. or invoices that were modified today

When these dates/invoice numbers have been entered, click the Next 
Button

QuickBooks Progress Invoices can be retrieved batch style with either a date or invoice number range or 
individually based on a specific invoice number to retrieve.



Setting Up CAPS to Work with QB:
Retrieval of Data & Creating Linked Records

As CAPS accesses the data 
file, it will begin compiling a 
list in this box of all the jobs 
that it finds that have a 
Customer Type of “AIA 
format” and a Status of “In 
Progress” in the QuickBooks 
job record based on the dates 
provided and will require you 
to “Create link to 
QuickBooks”.

Selecting Add will begin the 
process.

You will find it most helpful if your client is sitting with you during the initial “linking” process, as there is likely 
information that only they will know about the Jobs and the billing requirements.

Linked Records are created because there are several items that are required to comply with AIA Billing 
mandates that Quickbooks either has no means of tracking or doesn’t reliably provide its own internal 
linking, this linking process is done the first time that you run CAPS, and all information will then be 
remembered.  You will not be required to do any additional linking until CAPS finds a new Job, at which 
time you will be prompted just like this and walked through the setup.

How do I know that CAPS is retrieving the correct information?

Very good question.  The designer of this program, Nancy Smyth (who is a Certified QuickBooks ProAdvisor) 
has been generating AIA billings since 1991 using QuickBooks, therefore, she knew where all of the 
required information came from in QuickBooks – this knowledge has been coded into the CAPS program.

Troubleshooting:

There are a number of error messages that could occur here that relate directly to:

Incorrectly granting CAPS permission to access the QB data could result in error code 8004041D

Failure of the installation of the request processor required for CAPS to talk to QuickBooks resulting in error 
code 8007007E

The unsuccessful installation of a QuickBooks update produces various error code numbers and messages

A detailed listing of possible error codes as well as their resolution can be found at 

http://www.sunburstsoftwaresolutions.com/support-area.htm



Setting up CAPS to Work with QB –
Linking Jobs

The Project Name shown 
here is the same as your 
QuickBooks Job Name.

Following the instructions in 
the manual, complete the 
missing information for each 
Job that CAPS found.

Need to add an Architect?  
Simply press the Edit 
Architects button and then 
choose Add

When you have completed 
this information select Save



Setting up CAPS to Work with QB –
What does “linking” do?

In the case of CAPS (all integrated applications do not work the same) it means that the 
information that is contained in the QB Job Record and the corresponding record in CAPS for the 
same job are “tied” together and the information from both records can be merged and utilized in 
the various documents CAPS provides.



Setting up CAPS to Work with QB –
Linking Jobs – Viewing the Detail

After choosing to Save
the linked Job record 
you will be returned to 
the Step 1 Screen.  
Selecting the Detail 
button will take you to 
this screen.

Descriptions and 
Scheduled Amounts 
come from the QB 
Estimate, Current Bill 
comes from the 
Progress Invoice you 
created.

Select OK to return to 
the Step 1 Screen

The Detail Screen contains the information that will appear on the Continuation Sheet (G-
703).  The information shown in the Desctiption and Scheduled columns come from the 
QuickBooks Estimate and the Current Billed Column is pulled from the current Progress 
Invoice.

The Status Column allows you to easily pick up in the middle of a contract or re-create the 
history of a contract.  

Original means that an item was part of the Original Contract

Current means that an item is a Change Order that is Current as of this billing

Future means that an item is a Change Order that will occur in the future

Prior means that an item is a Change Order that happened in a prior billing

You can also specify where you would like to insert a Subtotal or a Page Break.



Setting Up CAPS to Work with QB –
Print or Preview?

Choosing to Preview is 
an effective means of 
verifying the accuracy 
of the bill prior to 
printing it out.

Choose to Print on 
blank paper or to 
Print on AIA forms.

Select Complete when 
you are finished

If a Run-time Error 91 occurs when you click the Preview button either Microsoft Excel is not installed or 
there is a problem with the Excel installation.  In most cases, starting Excel, going to the Help Menu and 
choosing Detect & Repair will solve the problem.  You will need to have your Office installation CD’s available.  
In rare instances you will need to uninstall and then reinstall Excel.



What happens after everything is linked?

CAPS will generate a completed G-702 Contractor Application for Payment by merging 

the information contained in the Linked records.

The first month that CAPS is run, it will take close to the same amount of time to link 

everything that it did to complete the billings by hand, but after the linked records have 

been established this same billing that used to take an hour to complete manually will 

literally take just minutes.



Why are these billings important?

If a contractor does not follow the requirements of the American Institute of Architects 
standard percentage of completion billing protocols, the contract’s bill will be rejected, and 
the payment will be delayed until such time as the problems are corrected.  Most of the 
time there is a 60-90 day wait before payment is made or the contractor is notified that 
there is a problem.  This can cause a very serious cash flow problem for contractors.



Customer Testimonial

“Words cannot express how much Sunburst Software has made my life easier.  I 
researched other construction accounting software packages that cost as much as 
$7000.00.  I purchased QuickBooks Premier 2002 along with the CAPS billing 
program.  The marriage of the two is the best solution to construction accounting 
needs.  My cost, total, was less than $600.00.  That’s a savings of over $6,400.  A 
small price to pay for such a robust package.  With a click of a mouse, your 
progress invoice is brought into CAPS with all the appropriate line items, 
percentages, retainage and stored materials all appropriately billed.  What used to 
take me an hour with a spreadsheet, now only takes me 2 minutes.”

Peter Adams, Accountant

Campbell Construction, Beverly, MA

(CAPS user since 2002)



Additional Information –
Resources on our website

Training Demonstrations, Whitepapers, case studies, product sheets & sample 
forms are available at 
http://www.sunburstsoftwaresolutions.com/app-for-payment-quick-tour.htm

Common Problems, Version 5.0 Error Messages specific to QB 2004, Version 5.0 
General Error Messages, Generating Negative or Credit Applications for Payment, 
Where does the information that appears on the G-702/G703 come from are 
available at 
http://www.sunburstsoftwaresolutions.com/support-area.htm

A general overview of AIA billing requirements are available at 
http://www.sunburstsoftwaresolutions.com/about-aia-billing.htm

Making use of the information that we provide free of charge on our website will make you 
look like an “AIA billing pro” when you talk to or work with your clients!



Common Problems

� No Invoices found – filtering parameters have not been set up in the QB Job 
Record – Customer Type=AIA format, Job Status=In Progress, normal invoices 
were created instead of Progress Invoices.  Read about setting up Jobs in the 
manual.

� Continuation Sheet does not match Progress Invoice – check the Preferences
section in the manual.  If you have selected Not to print line items with 0 
amounts this could cause the problem.

� Can’t connect to QuickBooks – request processor was not installed, permissions 
were not properly granted, or a QB update did not install properly

� No Project information showing on the Application for Payment – check the 
“Ship To” Address block in the QB Job Record.

Hurdles that are normally see with clients using CAPS

Failure to grant CAPS permission to access the QuickBooks data file

Users have insufficient permission in a networked environment

Failure to watch training demonstrations or read/follow provided setup instructions

QuickBooks is improperly setup

User’s have not been utilizing the Estimating & Progress Invoicing functionality

Insufficient knowledge on “how to use” QuickBooks

Mutilation of QuickBooks Estimate and/or Progress Invoice templates 



Top 5 Things That Will Cause Integration 
Problems

1. The QuickBooks Administrator is a Certified QuickBooks ProAdvisor or Accountant 
who is not readily available, and you cannot get their username and password, 
therefore, the software cannot be installed until they are able to come to your 
office to grant CAPS access to your data file.

2. As an accountant you close the books for the previous year, your client still has 
open jobs, and without the password they cannot modify the Estimates for those 
jobs that are still in progress.

3. In the QuickBooks Jobs & Estimates Company Preferences Tab, you have selected 
the “Don’t print items that have zero amount” option.  This cause CAPS to 
“go nuts” when you have many lines on your Estimate, but only bill for a few.

4. When recreating the job’s billing history in QuickBooks, you inadvertently have all 
your Progress Invoices dated for the same day.

5. There are multiple Estimates for the same job



When To Call Support

Feel free to contact technical support at any time 

by email:  sales@sunburstsoftwaresolutions.com

By phone:  (802) 895-4929

Via our on-line support forums: 
http://www.certifiedpayrollreports.com/forum/index.php

If you have an error code/message that you cannot diagnose from the error 
messages on our on-line support area at 
http://www.sunburstsoftwaresolutions.com/support-area.htm, please have both the 
error code # and error message available when you call.

“Learning about integration, is much like learning a foreign language…….you can’t go 

to a two week or even a two month course and expect to be fluent.”



How to request a FREE 30-day trial version 
of the software

A FREE 30-day trial is available on the Sunburst Software Solutions, 

Inc. website after viewing the flash demo.  The flash demo is 

included with the software as a training demonstration tool.  It

covers QuickBooks Setup along with Setup in CAPS and explains how 

the two programs work together.

Link to Flash Demonstration page: 

http://qb4contractors.com/app-for-payment-quick-tour.htm


